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KÄYTETYT TERMIT JA LYHENTEET  

 
AD  Active Directory, Aktiivihakemisto on Microsoftin toteutus 

hakemistopalvelusta. AD sisältää tietoa käyttäjistä, tietokoneista ja verkon 
resursseista. 

 
AD DS Active Directory Domain Services, Aktiivihakemiston toimialueen palvelut 
   
AD FS Active Directory Federation Services, tunnistuksen ja valtuutuksen hajaut-

taminen 
 
AD LDS Lightweight Directory Services, kevyt hakemistopalvelu 
 
AD RMS Rights Management Services, oikeuksien hallintapalvelu  
 
Bitlocker Tietovälineiden ja järjestelmän suojauspalvelu 
 
DHCP Dynamic Host Configuration Protocol, dynaaminen IP-osoitteiden 

ja -parametrien jakelupalvelu 
 
DNS  Domain Name System on internetin nimipalvelujärjestelmä, joka muuntaa 

verkkotunnuksia IP-osoitteiksi ja päinvastoin. 
 
Hypervisor Sovellus, joka mahdollistaa useamman käyttöjärjestelmän yhtäaikaisen 

toiminnan samalla fyysisellä koneella 
 
IP Internet Protocol, internet-protokolla on internet-kerroksen protokolla, joka 

huolehtii IP-pakettien toimittamisesta perille internet-verkossa. 
 
IP-osoite  Internet Protocol Address on internet-protokollan käyttämä osoite 
 
IPV4  Internet-protokollan neljäs versio. Yleisin internetissä käytössä oleva IP-

protokolla.  
 
IPV6  Internet-protokollan uusi versio, joka on tulevaisuuden korvaaja IPV4-

versiolle. 
 
LDAP  Lightweight Directory Access Protocol on protokolla, jota Active Directory 

käyttää hakemistosta tehtäviin hakuihin.  
 
NetBIOS  Network Basic Input/Output System on OSI-mallin istuntokerroksen 

palvelu, jonka avulla tietokoneet voidaan yksilöidä lähiverkossa.  
 
POP3  Post Office Protocol on sähköpostiviestien hakemiseen tarkoitettu 

protokolla.  
 
SMTP  Simple Mail Transfer Protocol on sähköpostiviestien välittämiseen 

sähköpostiohjelmasta vastaanottajalle tarkoitettu protokolla.  
 
SQL  Structured Query Language on stardardoitu kyselykieli, jolla voi tehdä 

relaatiotietokantaan erilaisia hakuja, muutoksia ja lisäyksiä.  



 

 

 
TCP/IP  Transmission Control Protocol / Internet Protocol on usean internet-

liikennöinnissä käytettävän tietoverkkoprotokollan yhdistelmä.  
 
VPN Virtual Private Network on yksityinen verkko, joka rakennetaan yli 

turvattoman julkisen verkon 
 
WDS Windows Deployment Services, Windows-asennuspalvelin 
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1 Johdanto 
 

Tässä työssä valmistettiin oppimateriaalit ammattikorkeakoulu Metropolian Windows 

Server 2008 -ylläpito (70-646) -kurssia varten. Lisäksi luotiin ja testattiin 

virtuaaliympäristö palvelinklusteriin, jossa harjoitukset tehdään VMware-

virtuaaliympäristössä. Työssä kuvataan aluksi lyhyesti Server 2008 -käyttöjärjestelmän 

erot opetuksessa aiemmin käytettyyn Server 2003:een nähden. Seuraavaksi esitetään 

kurssin tavoitteet, sisältö ja toteutus. Työn keskeisen osan muodostavat 

luentomateriaalin ja harjoitusten rakentaminen ja testaus. Harjoituksissa käytettävän 

ympäristön rakenne ja toiminta kuvataan työn alussa. Työn lopussa kerrotaan 

ensimmäisen pilot-kurssin kokemuksista. 

 

Kurssi Windows Server 2008 -ylläpito kuuluu Tietoverkkojen opetusohjelmaan ja se 

tarjotaan sekä nuorisokoulutuksessa että aikuiskoulutuksen iltaopetuksessa ja 

avoimessa ammattikorkeakoulussa. Kurssi valmentaa Microsoftin sertifikaattiin Pro: 

Windows Server 2008, Server Administrator. Sen vaatimukset ovat: 

 

“A server administrator is responsible for the operations and day-to-day management 

of an infrastructure of servers for an enterprise organization. Windows server adminis-

trators manage the infrastructure, Web, and IT application servers. The Windows serv-

er administrators use scripts and batch files written by others or those that they occa-

sionally write themselves to accomplish tasks on a regular basis. They conduct most 

server management tasks remotely by using Terminal Server or administration tools 

installed on their local workstation. A server administrator‟s primary tasks include: 

 Managing the server operating system, file, and directory services 

 Software distribution and updates 

 Profiling and monitoring assigned servers 

 Troubleshooting. 

 

Server administrators also support engineering projects. Server administrators are re-

sponsible for server builds and configuration. Their job role involves 60 percent opera-

tions, 20 percent engineering, and 20 percent support tasks.” [2] 
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2 Microsoft Windows Server 2008 
 

Ennen oppimateriaalin kuvausta kerrotaan lyhyesti Microsoft Windows Server 

2008 -käyttöjärjestelmästä ja sen ominaisuuksista. Windows-palvelinohjelmistojen 

historian voidaan katsoa alkaneen jo vuonna 1993, jolloin Microsoft julkaisi Windows 

NT 3.1 Server:n. Sen kehitystä jatkettiin aina vuoteen 1998 asti, jolloin viimeisin versio 

NT 4.0 Terminal Server julkaistiin. Vuonna 2000 Microsoft julkaisi Windows 2000 

Server:n, jonka ominaisuuksiin kuuluvat muun muassa aktiivihakemisto, hajautettu 

tiedostojärjestelmä (DFS) ja kiintolevyjen RAID-konfigurointi. Vuonna 2003 markkinoille 

tuotu Windows Server 2003 oli kehitysaskel Windows-palvelinohjelmistoissa ja toi 

parannuksia muun muassa aktiivihakemiston toimintaan. Windows Server 2003 tukee 

verkkokuormantasausta (NLB), ja Enterprise- ja Datacenter -versiot sisältävät työkalut 

vikasietoisen klusterin rakentamiseen ja hallintaan. 

 

Server 2008 on uusin Windows Server -käyttöjärjestelmäperheen jäsen. Se julkaistiin 

27. helmikuuta 2008 edellisen sukupolven Windows Server 2003 -käyttöjärjestelmän 

korvaajaksi. Työasemakäyttöjärjestelmä Windows Vista:n/Windows 7:n tavoin 

Windows Server 2008 käyttää Windows NT 6.0 Service Pack 1 -käyttöjärjestelmän 

ydintä (kernel). 

 

Microsoft Windows Server 2008 pohjautuu NT 6.x-koodiin, jonka päälle myös Windows 

Vista ja Windows 7 on rakennettu. Ne sisältävät samat arkkitehtuuriset uudistukset ja 

toiminnalliset parannukset. Windows Server 2008 -käyttöjärjestelmästä on olemassa 

yhdeksän erilaista versiota. Näiden versioiden lisäksi jokainen versio on saatavilla sekä 

32- että 64-bittisille suoritinkannoille. Huomattavin uudistus Windows Server 2008 

palvelinjärjestelmässä on Server Core -teknologia. [1]  

 

Toinen revisio, R2, Microsoft Windows Server 2008 -palvelinjärjestelmästä julkaistiin 

22. heinäkuuta 2009. Siitä on saatavilla seuraavat versiot. 

 Windows Server 208 R2 Foundation 

 Windows Server 2008 R2 Standard 

 Windows Server 2008 R2 Enterprise 

 Windows Server 2008 R2 Datacenter 

 Windows Web Server 2008 R2 
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 Windows HPC Server 2008 

 Windows Server 2008 R2 for Itanium-Based Systems. 

 

Järeimmät Datacenter- ja Enterprise-versiot käyttöjärjestelmästä ovat 

toiminnallisuudeltaan ja ominaisuuksiltaan hyvin samanlaiset. Kummatkin on tarkoitettu 

pääosin isoille yrityksille ja organisaatioille. Kummassakin ovat mukana kaikki 

käyttöjärjestelmää varten kehitetyt ominaisuudet, joista osa puuttuu suppeammissa 

versioissa. Näiden kahden version keskeisin ero on palvelinlaitteiston tuettujen 

suorittimien määrässä, Datacenter-versiossa palvelinkoneessa voi olla peräti 

kuusikymmentäneljä moniydinsuoritinta, kun taas Enterprise tukee vain kahdeksaa 

vastaavaa suoritinta. Keskusmuistin tuettu määrä on massiivinen, peräti kaksi 

teratavua. Tässä työssä laadittu oppimateriaali on sovitettu Server 2008 R2 

Enterprise-versioon. 

 

Standard-versio Windows Server 2008:sta on ominaisuuksiltaan rajatumpi, kuin 

Datacenter- ja Enterprise -versiot. Se tukee maksimissaan neljällä 

moniydinsuorittimella ja korkeintaan 32 gigatavun keskusmuistilla varustettua 

laitteistoa. Keskeisin puute kahteen kattavimpaan järjestelmäversioihin verrattuna on 

vikasietoisten ryppäiden (Failover clustering) konfiguraatiotietojen 

hajauttamisominaisuuden puuttuminen. 

 

Seuraavat Server 2003 toiminnot eivät ole enää mukana Server 2008:ssa: 

 NT Backup on korvattu Windows Server Backup ohjelmalla, joka ei tue 
nauhavarmistuksia. 

 NNTP (Network News Transfer Protocol) ei ole osa web-palvelinta, In-
ternet Information Services 7.0:aa. 

POP3 (Post Office Protocol) -sähköpostipalvelinprotokolla ei tule Windows Server 

2008:n mukana. 
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3 Server 2008:n uudet ominaisuudet 

3.1 Aktiivihakemisto (Active Directory) 
 

Aktiivihakemisto (Active Directory) on Microsoft:n kehittämä hakemistopalvelu, jonka 

avulla pystytään hallitsemaan tietoa toimialueen käyttäjistä, tietokoneista ja erilaisista 

verkkoresursseista. Niitä voidaan jakaa eri sovellusten ja käyttäjien kesken. 

Aktiivihakemistorooli otettiin käyttöön ensimmäisen kerran Windows 

2000 -käyttöjärjestelmän Server -versiossa 2000-luvun taitteessa ja se on sen jälkeen 

kuulunut keskeisenä osana Windows Server -käyttöjärjestelmiin. 

 

Active Directory:n uusi nimi Server 2008:ssa on Active Directory Domain Services 

(ADDS). Active Directory:n tehtävä on vähentää ylläpidettävien hakemistojen määrää. 

Toimialueen resurssien, esimerkiksi käyttäjätilien ja tietokonetilien hallinta voidaan 

tehdä yhtenäisillä rajapinnoilla ja työkaluilla. Tärkein aktiivihakemiston hallintakonsoli 

on Active Directory Users and Computers (kuva 1). Sen avulla konfiguroidaan ja 

hallitaan Aktiivihakemiston säiliöitä, organisaatioyksiköitä ja objekteja. 

 

Kuva 1. Active Directory Users and Computers-konsoli 
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Toimiakseen kunnolla Aktiivihakemisto tarvitsee DNS-palvelinroolin asennettuna 

mielummin samalle fyysiselle tai virtuaalipalvelimelle, kuin mihin Aktiivihakemisto on 

asennettu. DNS-palvelinrooli kuvaa järjestelmän loogisen rakenteen, toisin sanoen 

aktiivihakemiston toimialueen objektit ja palvelut saavutetaan sen avulla ja käyttäjät ja 

verkkoresurssit saavat helpomman muistettavan ja tunnistettavan nimen. 

 

Keskeisimmät uudistukset aktiivihakemistossa liittyvät Federation Services- (AD FS), 

Lightweight Directory Services- (AD LDS) ja Rights Management Services (AD 

RMS) -palvelurooleihin. AD FS -roolin avulla pystytään luomaan laajennettava ja 

turvattu useiden käyttöjärjestelmien välillä toimiva tunnistuspalvelu. AD LDS on 

nimensä mukaisesti erittäin kevyt ja karsittu versio laajemmasta AD 

DS -ominaisuudesta, joskin se pohjautuu erilaiseen tietokantapohjaan. AD RMS -roolilla 

voidaan suojata sovelluksia ja tiedostoja kuten intranet-sivustoja ja sähköpostiviestejä 

(kuva 2). 
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Kuva 2. Aktiivihakemiston komponentit 

3.2 Server Core 
 

Yhtenä huomattavimmista uudistuksista Windows Server 2008  palvelinjärjestelmässä 

on Server Core  -teknologia. Käytännössä se on yksi käyttöjärjestelmän 

asennusvaihtoehdoista. Server Core  asennus jättää kaiken tarpeettoman 

asennuksessa pois kuten käyttöliittymän, .NET Framework:n  ja Internet Explorer:n. 

Vain kaikki käyttöjärjestelmän kannalta tärkeät ominaisuudet asennetaan. 

Käyttöliittymää hallinnoidaan komentotulkin avulla. Server Core:en on kuitenkin 

mahdollista asentaa eri rooleja, kuten esimerkiksi ohjauspalvelin (Active Directory 

Domain Services), nimipalvelin (DNS Server) ja DHCP Server. 
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3.3 Read-Only Domain Controller (RODC) 
 

Kuten nimestäkin saattaa arvata, Read-Only Domain Controller (RODC) on 

ohjauspalvelimen erikoistapaus, jossa on kopio Active Directory:n tietokannasta, mutta 

sitä voidaan ainoastaan lukea. Kaikki kirjoituspyynnöt ohjataan isäntä-

ohjauspalvelimelle. RODC-ohjauspalvelimelle voidaan määritellä järjestelmänvalvojatili, 

jolla on oikeus hallita vain kyseistä RODC ohjauspalvelinta. 

3.4 Hyper-V 
 

Virtualisointi tarkoittaa, että yhdessä fyysisessä palvelimessa on mahdollista ajaa 

samanaikaisesti useita eri käyttöjärjestelmiä. Esimerkiksi jokin ohjelmisto voi vaatia 

toimiakseen vanhempaa palvelinkäyttöjärjestelmäversiota, ja kyseistä versiota voidaan 

ajaa virtualisoituna uudemman käyttöjärjestelmän palvelimessa. Kun yhdessä 

palvelimessa ajetaan virtualisointiohjelmistoa, päästään keskitetyn hallinnan avulla 

eroon monista vajaakäytössä olevista palvelimista. 

  

Virtuaalipalvelinten toteutustapoja on kaksi, VM monitor ja hypervisor. VM monitor on 

sovellus, joka luo virtuaalikoneita ja hallitsee niiden pääsyä laitteistoon. VM monitor:a 

ajetaan samalla tavalla kuin esimerkiksi tietokantapalvelinta. Hypervisor eroaa VM 

monitor -tyyppisistä ratkaisuista tarjoamalla paremman luotettavuuden ja 

suorituskyvyn. Se korvaa perinteisen isäntäkäyttöjärjestelmän ohuella kerroksella 

erityistä käyttöjärjestelmäohjelmistoa. Hypervisor on sovitettu nimenomaan 

virtualisointikäyttöä varten ja siksi se ei sisällä täyden käyttöjärjestelmän kaikkia 

ominaisuuksia. 

 

Hyper-V on Microsoft:n kehittämä käyttöjärjestelmien virtualisointijärjestelmä 64-

bittisille Windows Server 2008 -käyttöjärjestelmille. Hyper-V on mahdollista asentaa 

erilliseksi palvelinrooliksi, jonka kautta pystytään asentamaan ja hallinnoimaan useita 

eri virtuaalikoneita. Virtuaalikoneiksi voidaan asentaa toisia Windows 

Server -palvelinkäyttöjärjestelmiä, Windows-työasemajärjestelmiä tai kolmannen 

osapuolen käyttöjärjestelmiä kuten Linux. 

 

Itse virtuaalikoneiden puolella laitteisto ja niiden ajurit ovat virtuaalisia, kuten 

käyttöjärjestelmäkin. Hyper-V sisältää valtavan määrän eri laitteistoajureita itsessään, 
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joten useammanlaisten laitteiden simulointi onnistuu. Hyper-V:n alla toimivilla 

virtuaalikoneilla ei kuitenkaan ole suoranaista pääsyä isäntäkoneen suorittimelle, vaan 

ne käyttävät virtuaalista näkymää suorittimesta. 

 

Fyysisen isäntäkoneen ja Hyper-V:n yhdistää toisiinsa hypervisor. Hypervisor on 

eräänlainen ohjelmistokerros, joka luo eristetyn toimintaympäristön, osion, 

virtuaalikoneille sekä hallinnoi ja valvoo virtuaalikoneiden pääsyä fyysisen isäntäkoneen 

laitteistoresursseihin. 

3.5 Active Directory:n tietokannan käsittelytyökalu 
 

Dsamain.exd on Active Directory:n tietokannan käsittelytyökalu. Sen avulla voidaan 

tutkia Active Directory:n tietokannan varmuuskopioita. Varmuuskopioiden tutkiminen ei 

vaadi niiden palauttamista ohjauspalvelimelle. 

3.6 Uudelleenkäynnistettävä Active Directory 
 

Active Directory:n uudelleenkäynnistäminen mahdollistaa ADDS:n pysäyttämisen ja 

uudelleenkäynnistämisen ilman, että koko ohjauspalvelin on käynnistettävä. 

3.7 Windows PowerShell 
 

Windows PowerShell on skripti- ja komentotulkki, joka voi korvata myös komentotulkin 

Cmd.exe ja skriptitulkin Windows Script Host. Se perustuu .NET Framework -alustaan 

ja toimii yhdessä Windows Management Instrumentation:n ja rekisterin (registry) 

kanssa. 

3.8 Remote Desktop Connection 
 

Remote Desktop Connection on ohjelma, jolla voidaan ottaa etäyhteys 

virtuaalikoneisiin. Windows-käyttöjärjestelmissä Remote Desktop Connection on 

valmiiksi asennettuna. Ennen kuin yhteys luodaan, tulee virtuaalikoneen 

käyttöjärjestelmässä sallia Remote Desktop Connection -toiminto. Yhteys 

virtuaalikoneeseen saadaan käynnistämällä ohjelma ja syöttämällä palvelimen nimi tai 

IP-osoite sille tarkoitettuun kohtaan kirjautumissivulla. (Kuva 3) 
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Kuva 1. Remote Desktop Connection 

3.9 Terminal Services 
 

Windows-päätepalveluissa on huomattavia uudistuksia. Windows Server 2008 Terminal 

Services Remote Apps mahdollistaa sovelluksien ajamisen etänä. Tällöin 

päätepalvelimen ohjelma voidaan ajaa asiakastyöasemaan ilman asiakaskoneelle 

kirjautumista. Muita uudistuksia ovat selainpohjainen käyttö (Terminal Services Web 

Access) ja päätepalveluiden yhdyskäytävä (Terminal Services Gateway). 

3.10 Hienosäädetyt salasanakäytännöt (Fine-Grained Password Policies) 
 

Vanhemmissa palvelinjärjestelmissä on määritelty vain yksi toimialueen 

salasanakäytäntö (Default Domain Policy). Windows Server 2008 -toimialueella on 

mahdollista käyttää useita eri salasanakäytäntöjä, jotka voidaan kohdistaa tiettyihin 

käyttäjä- tai ryhmätileihin. 

3.11 Ryhmäkäytäntökonsoli (Group Policy Management Console) 
 

Group Policy Management Console on ryhmäkäytäntöjen hallintakonsoli. Tämä 

ominaisuus asennetaan automaattisesti, jos palvelin asennetaan ohjauspalvelimeksi. 

Kaikki metsän (forest) ja luottosuhteiden kautta myös muiden metsien 

ryhmäkäytäntöobjektit ovat käsiteltävissä ja niitä voidaan myös indeksoida ja 

kommentoida. Ryhmäkäytäntöjen oletusasetuksia voidaan muuttaa, esimerkkinä 

automaattinen verkkoaseman käyttöönotto. 
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Kuva 2. Ryhmäkäytäntökonsoli 

3.12 Windows System Resource Manager 
 

Windows System Resource Manager:n avulla voidaan rajoittaa palvelimen resurssien 

käyttöä. 

3.13 Windows Server Backup 
 

Aivan uudella varmuuskopiointiohjelmalla Windows Server Backup:lla voidaan ottaa 

varmuuskopioita myös koko järjestelmästä. Varmuuskopiot voidaan tallentaa 

kiintolevylle, CD- tai DVD-levylle tai verkkoasemaan. Järjestelmän täydellisen 

palautuksen voi tehdä Complete PC Backup:n avulla, jos esimerkiksi käytössä oleva 

kiintolevy hajoaa. 

3.14 Server Manager 
 

Server Manager on uusi hallintatyökalu, jolla voidaan asentaa ja hallita kaikkia 

palvelimen rooleja ja ominaisuuksia. Se toimii vain paikallisesti, mutta sitä voidaan 

käyttää etänä (Terminal Services Remote Application -palvelun avulla). Server 

Manager:n komponentit selviävät seuraavasta kuvasta. (Kuva 5) 
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Kuva 3. Server Manager -ikkuna 

3.15 Windows Deployment Services 
 

Windows Deployment Services (WDS) korvaa aiemmat Windows-käyttöjärjestelmien 

asennuspalvelut, Automated Deployment Services ja Remote Installation Services. 

Windows Deployment Services mahdollistaa Windows-käyttöjärjestelmien käyttöönoton 

verkkopohjaisen asennuksen kautta. Tällöin ei välttämättä tarvita fyysistä 

asennusmediaa. 

 

3.16 Windows-kehitysympäristöt 
 

.NET Framework on Microsoft:n kehittämä ohjelmistokomponenttikirjasto, jota 

Microsoft:n VisualStudio.NET-ympäristössä kehitetyt ohjelmistot käyttävät. Uusin 

VisualStudio.NET-versio on 2008. NET Framework alijärjestelmineen (WCF, WPF ja WF) 

tulee Windows Server 2008:n mukana. Services for UNIX on uudelleen nimetty Subsys-

tem for UNIX-based -sovellukseksi. Network File System (NFS) -asiakas sisältyy myös 

Subsystem for UNIX-based -sovellukseen. Seuraavaksi on lueteltuna uusia 

diagnostiikkaominaisuuksia. 
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 Windows Disc Diagnostics on sisäänrakennettu levydiagnostiikka, joka 

havaitsee levyongelmat. Se opastaa käyttäjää varmuuskopioinnissa, 

levyn vaihtamisessa ja tietojen palauttamisessa. Apuna käytetään 

SMART (Self-Monitoring, Analysis and Reporting 

Technology) -teknologiaa, joka on ominaisuutena nykyaikaisissa 

kiintolevyissä. 

 Windows Memory Diagnostics on keskusmuistidiagnostiikka. Sen 

tarkoituksena on havaita muistiongelmat ja suorittaa muistintestaus. 

Windows Memory Diagnostics toimii yhdessä kaatumisongelmien 

diagnostiikkatyökalun (Microsoft Online Crash Analysis) kanssa. 

Muistintestausta voidaan hallita keskitetysti ryhmäkäytäntöjen avulla. 

 Widows Networks Diagnostics on verkon diagnostiikkatyökalu. 

Suorittamalla useita normaaleja tietoliikenneyhteyden testauksia se 

tarjoaa mahdollisuuden verkko-ongelmien paikantamiseen ja 

korjaamiseen. 

 Problem Reports and Solutions on ongelmien raportointia ja ratkaisuja 

tarjoava sovellus. Se tarjoaa ratkaisuvaihtoehtoja järjestelmässä 

havaittujen ongelmien ratkaisemiseksi. 

4 Harjoitusympäristö 
 

Kurssiin liittyvät käytännön harjoitukset tehdään virtuaalisessa VMware-ympäristössä. 

Metropolian Tietoverkkojen palvelinklusteri koostuu kuudesta korttipalvelimesta. 

Palvelinklusteriin on asennettu Vmware ESX -järjestelmä, jota käytetään 

työympäristönä. Kolme kuudesta korttipalvelimesta ovat Dell PowerEdge 1855 -koneita 

ja loput kolme ovat Dell PowerEdge 1955 -koneita. 1855-sarjan palvelimissa on 

kahdeksan gigatavua muistia ja jokaisessa on kaksi Xeon-prosessoria, jotka toimivat 3 

GHz:n kellotaajuudella. Levytilaa näille palvelimille on varattu 1,3 teratavua. 1955-

sarjan palvelimissa on 16 gigatavua muistia ja jokaisessa kaksi Xeon 

E5345 -prosessoria, jotka toimivat 2,33 GHz:n kellotaajuudella. Näille palvelimille on 

varattu 1,4 teratavua levytilaa. 
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Ylimääräistä muistia on varattu 900 gigatavua palvelinklusterien välille ja palvelimien 

yhteysprotokollana levyjärjestelmiin toimii Internet Small Computer System Interface 

(iSCSI). Jokaisessa palvelimessa on kaksi verkkokorttia. Ne ovat yhteydessä kahteen 

kytkimeen, joista toinen toimii verkkoliikenteen ylläpitäjänä ja toinen on liitetty Dell AX 

150i -levyjärjestelmään. Palvelinklusterille on varattuna neljä virtalähdettä, joista yksi 

on varavirtalähde ongelmatilanteita varten. 

4.1 VMware ESX 
 

Wmware ESX on palvelimien virtualisointiohjelma. Se on itsenäinen käyttöjärjestelmä ja 

mahdollistaa useiden virtuaalikoneiden samanaikaisen käytön. Virtualisointiohjelmassa 

on kaksi työkalua, VirtualCenter ja Vmotion. VirtualCenter:llä voidaan hallita useaa 

ESX-palvelinta samanaikaisesti. Itse VirtualCenter koostuu sekä Server- että Client-

osiosta. Server-järjestelmä on kiinteästi yhteydessä virtualisointialustoihin (ESX) ja 

kerää niistä jatkuvasti tilatietoja. Client:lla voidaan taas kertoa muutoksia Server:lle, 

joka taas suorittaa muutokset järjestelmään. 

4.2 vSphere-konsoli 
 

VMware vSphere-konsolia käytetään VMware-palvelimeen asennettujen 

käyttöjärjestelmien hallintaan. Jos virtuaalikoneen IP-asetukset ovat väärin tai kone ei 

ole käynnissä, siihen on otettava yhteys vSpherellä.  vSpheren avulla kone voidaan 

käynnistää ja sen sisäänrakennetun konsolin on mahdollista avata hallinta yhteys 

virtuaalikoneeseen. vSphere-konsolia ei voida käyttää etäyhteydellä, joten 

opiskelijoiden on aina varmistuttava, että virtuaalikoneet ovat käynnissä ja niiden IP-

asetukset ovat oikein, jos harjoituksia halutaan tehdä muualla kuin oppilaitoksen 

verkossa. 

4.3 Vmotion 
 

Vmotionia voidaan käyttää, kun käytössä on vähintään kaksi ESX-järjestelmää ja näillä 

yhteinen levyalue. Vmotion mahdollistaa virtuaalikoneiden liikuttamisen ESX-

järjestelmien välillä ilman tuotannollista katkoa. VirtualCenter Server koordinoi 

virtuaalikoneiden siirron. 
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5 Kurssin suunnittelu ja materiaali 

 
Kurssimateriaalin suunnittelu perustuu viralliseen, Microsoft IT-akatemian kurssilla 70-

646 käytettävään oppaaseen MCITP Self-Paced Training Kit (Exam 70-646): Windows 

Server 2008 Administrator, ISBN 10: 0-7356-2510-7 [1].  

 

”IT Academy -ohjelma on kokonaisvaltainen Microsoft teknologian ja osaajien 

koulutusohjelma, jonka avulla tietotekniikan oppilaitokset voivat kehittää 

opiskelijoidensa uramahdollisuuksia. Ohjelmassa mukana olevat oppilaitokset voivat 

tarjota opiskelijoilleen Microsoft -sertifiointitutkintokoulutusta. Tätä tarkoitusta varten 

oppilaitoksille on kehitetty kurssi- ja opetusmateriaaleja sekä kouluttajien 

tukityökaluja.” 

 

Kurssi valmentaa Microsoftin sertifikaattiin Microsoft Certified IT Professional (MCITP): 

Server Administrator [2]. Kurssi ei itsessään oikeuta sertifikaattiin, mutta sen aihepiiri 

on sama kuin sertifikaattikokeessa. 

 

Työssä syntynyt oppimateriaali muodostuu luentokalvoista ja harjoitusohjeista. 

Luentomonistetta ei katsottu tarpeelliseksi laatia, koska IT Academy -säännösten 

mukaan virallisilla kursseilla on käytettävä MOAC-kurssimateriaalia (Microsoft Official 

Academy Course).  

 

Testausta ja harjoitusten valmistelua varten rakennettiin toimialue Contoso.com ja 

kaksi virtuaalipalvelinta. 

 Ohjauskone TV08KDC22, IP-osoite: 10.95.250.217 

 Jäsenpalvelin TV08KSRV22, IP osoite: 10.95.250.218. 

Virtuaalikoneiden luomisen jälkeen lähdettiin käymään läpi oppimateriaalia ja 

harjoituksia kappale kerrallaan. Minimikonfiguraatio harjoitusten tekemiselle oli: 

 512 megatavua keskusmuistia 

 10 gigatavua kovalevytilaa. 

 

Virtuaalikoneisiin päätettiin kuitenkin laittaa muistia ja kovalevyä kaksinkertainen 

määrä, jotta se varmasti riittäisi ja tarvittaessa olisi varaa asentaa uusia ohjelmia sekä 

tallentaa tiedostoja ja uutta tietoa koneille.  
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Luentokalvot laadittiin oppaan MCITP Self-Paced Training Kit (Exam 70-646): Windows 

Server 2008 Administrator päälukujen perusteella. Laboratorioharjoitukset muokattiin 

toimimaan VMware-ympäristössä. 

5.1 Virtuaalikoneiden käyttö 
 

Harjoituksissa jokaisella opiskelijalla on käytössään kaksi virtuaalikonetta ja oma 

toimialue. Virtuaalikoneet ovat samanlaisia, kuin kurssin laadinnassa käytetyt 

virtuaalipalvelimet. Virtuaalikoneet sijaitsevat Metropolia:n Tietoverkkojen 

palvelinklusterissa. 

 

Koneet ovat samassa verkossa peräkkäisissä IP-osoitteissa. Jokaiselle opiskelijalle 

annetaan kurssin alussa virtuaalikoneet ja niihin liittyvät IP-osoitteet. IP-osoitekartat 

ovat myös nähtävissä luokan kurssin tuubi-työtilassa. IP-osoitteet on jaettu yksityisestä 

laboratorioverkosta alueelta 10.95.25x.xxx - 10.95.25x.xxx. Virtuaalikoneiden nimet 

ovat LuokkaDCxx ja LuokkaSRVxx, jossa ‟Luokka‟ on oppilaan luokan tunnus ja xx on 

ryhmän (opiskelijan) tunnus. Toimialueena on Contosoxx.com, jossa xx on ryhmän 

tunnus. 

 

Virtuaalikoneita voidaan käyttää oppilaitoksen sisäverkosta suoraan tai ulkopuolelta 

tunneloitua ssh-yhteyttä käyttäen. Yksi tapa etäyhteyden rakentamiseen on asentaa 

etäkoneeseen ilmainen Putty-ohjelma, jonka konfigurointi on esitetty kuvassa 7. Siinä 

määritellään kohde-virtuaalikone ja lähdeportti (kuvassa 6000) sekä kohdekone ja sen 

portti 22. Tunneloitu yhteys on mahdollinen vain, jos virtuaalikone on käynnissä ja sen 

IP-asetukset ovat oikein. 
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Kuva 4. Putty-etäyhteyden konfigurointi 

 

Konfiguroinnin jälkeen putty käynnistetään ja Metropolia:n järjestelmään kirjaudutaan 

omilla tunnuksilla (kuva 8), minkä jälkeen virtuaalikoneeseen päästään Remote 

Desktop -yhteydellä (kuva 9). 

 

Kuva 5. Putty-kirjautuminen 

 
Remote Desktop -yhteys muodostetaan paikalliseen koneeseen, josta se tunneloituu 

Metropolia:n verkkoon putty:n konfiguroinnissa määritellyn portin kautta. 

 

Kuva 6. Yhteyden muodostus virtuaalikoneeseen 
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Virtuaalikoneiden ylläpito ja käyttö sisäverkossa on mahdollista myös VMware 

vSphere -palvelun avulla. Seuraavissa kuvissa on esitetty vSphere-yhteyden aloitus. 

 

Kuva 7. VMware vSphere -yhteyden aloitus 

vSphere-konsolissa voidaan virtuaalikone käynnistää ja sammuttaa, avata konsoli-

ikkuna ja kirjautua sisään vieraskäyttöjärjestelmään. Etäkäyttö ja käyttö Remote 

Desktopilla on mahdollista vain, kun virtuaalikoneet ovat käynnissä ja niiden IP-

asetukset ovat oikein. Jos näin ei ole, virtuaalikoneet on käynnistettävä ja 

konfiguroitava vSpherellä oppilaitoksen verkossa. 

 

Kuva 8. VMware vSphere -työtila 
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5.2 Kurssin jaottelu 
 

Kurssin oppikirjassa on 12 lukua, jotka kukin sisältävät useita tietokoneilla tehtäviä 

harjoituksia. Kaikki materiaali on englanninkielistä, koska kurssi tarjotaan myös 

avoimen ammattikorkeakoulun opiskelijoille. Kurssin sisältö on: 

1. Planning Server Deployments 

2. Planning Infrastructure Services 

3. Planning an Active Directory Deployment 

4. Planning Application Services 

5. Planning File and Print Services 

6. Planning Storage Solutions 

7. Planning for High Availability 

8. Planning Server and Network Security 

9. Securing Infrastructure Services 

10. Managing Servers 

11. Monitoring Servers 

12. Backing Up 

 

5.3 PowerPoint-esitykset ja niihin liittyvät harjoitukset 
 

Työssä laadittiin 12 PowerPoint-esitystä ja tietokoneharjoitusta, yksi kutakin oppikirjan 

lukua kohden. PowerPoint-kalvot ja harjoitusohjeet ovat erillisinä dokumentteina. 

Esimerkki PowerPoint-esityksestä on liitteenä 1 ja harjoituksesta liitteenä 2.  

Seuraavassa kuvataan kunkin esitys- ja harjoitusjakson (luvun) rakenne. 

5.3.1 Luku 1. Planning Server Deployment 

Ensimmäisessä luvussa tutustutaan aluksi Windows Server 2008:n eri versioihin ja 

järjestelmävaatimuksiin. Seuraavaksi käsitellään automatisoituja asennusmenetelmiä ja 

niiden käyttöönottoa. Tämän jälkeen käyttöjärjestelmä asennetaan tekemällä ns. 

normaali asennus (stand-alone). Asennuksen jälkeen tutustutaan Server 

Manager -konsoliin ja palvelin korotetaan ohjauskoneeksi (Domain Controller), minkä 

jälkeen siihen asennetaan levynsuojausjärjestelmä Bitlocker. 

Ohjauskoneeseen asennetaan Windows Deployment Services -rooli (WDS, Windows-

asennuspalvelin), jonka avulla käyttöjärjestelmien asennus voidaan suorittaa 
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keskitetysti. Lopuksi tutustutaan käyttöjärjestelmän asentamiseen vastaustiedostojen 

ja käyttöjärjestelmäimagojen avulla. 

Esityskalvot 
 

Selecting a Windows Server 2008 Edition 
 Introducing Windows Server 2008 Features and Capabili-

ties 
 Using Server Core 
Inventorying Hardware 

 Installing Microsoft Assessment and Planning Solution 
Accelerator 

 Using Microsoft Assessment and Planning Solution 
Automating Server Deployments 
 Using Windows Deployment Services 
 Customizing WDS Client Installations 
 Using the Windows Automated Installation Kit 

 
Using the Windows Automated Installation Kit 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Performing Initial Configuration Tasks 
2 Using Server Manager 
3 Installing the Windows Deployment Services Role 
4 Configuring WDS 
5 Adding Images 
6 Installing Windows System Image Manager 
7 Using Windows System Image Manager 

 

5.3.2 Luku 2. Planning Infrastructure Services 
 

Toisen luvun painopiste on verkkopalveluissa. Tietoverkkojen keskeiset palvelut, 

dynaaminen IP-osoitteiden jakelu (DHCP) ja nimipalvelu (DNS), esitellään 

yksityiskohtaisesti. Toimialueeseen asennetaan toinen nimipalvelin, nimipalvelimeen 

konfiguroidaan uusi vyöhyke ja siihen lisätään resurssitietueita.  

Ohjauskoneeseen asennetaan DHCP-rooli ja siihen konfiguroidaan kohdealue (scope), 

jonka avulla asiakkaille jaellaan IP-osoitteet ja muut verkkoparametrit.  

 
Esityskalvot 
 

Deploying DHCP Servers 

 Understanding DHCP Communications 

 Designing a DHCP Infrastructure 

 Deploying a DHCP Server 

 Deploying a DHCP Relay Agent 
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Deploying DNS Servers 

 Understanding the DNS Architecture 

 Designing a DNS Deployment 

 Creating Internet Domains 

 Creating Host Names 

 Deploying a DNS Server 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Designing a DNS Namespace 
2 Installing the DNS Server Role  
3 Creating a Zone 
4 Creating Domains 
5 Creating Resource Records 
6 Installing the DHCP Role 

 

5.3.3 Luku 3. Planning an Active Directory Deployment 
 

Kolmannessa luvussa tutustutaan aktiivihakemiston käyttöön, käydään läpi mm. 

käyttäjäryhmien suunnittelua, toimialueen suunnittelua ja niiden hallitsemista. 

Aktiivihakemisto, joka on Server 2008 -pohjaisten järjestelmien tärkein osa, käydään 

läpi yksityiskohtaisesti. Aluksi käydään läpi aktiivihakemiston toimintaperiaatteet ja 

rakenne. Sen jälkeen tutustutaan aktiivihakemiston asentamiseen ja erilaisiin 

aktiivihakemiston hierarkioihin.  

Esityskalvot 
 

Introducing Active Directory 

 Understanding Active Directory Functions 

 Understanding the Active Directory Architecture 

 Understanding Active Directory Communications 
Designing an Active Directory Infrastructure 

 Designing the Domain Name Space 

 Designing an Internal Domain Structure 

 Designing a Group Policy Strategy 
Deploying Active Directory Domain Services 

 Installing the Active Directory Domain Services Role 

 Creating a New Forest 

 Creating a New Child Domain in a Forest 

 Adding a Domain Controller to an Existing Domain 

 
Laboratorioharjoitukset 
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Harjoitus Sisältö 

1 Installing Active Directory Domain Services 

2 Configuring DNS  

3 Joining Member Server to Domain 

4 Installing Server Features 

5.3.4 Luku 4. Planning Application Services 

Neljännessä luvussa tarkastellaan palvelinrooleja ja tutustutaan ohjelmien 

asennukseen ryhmäkäytännön ja System Center:n avulla. Palvelimeen 

asennetaan ja konfiguroidaan päätepalvelinjärjestelmä, Terminal Services. 

Lopuksi tutustutaan Microsoft:n virtualisointiratkaisuun Hyper-V. 

Esityskalvot 
 

Deploying Application Servers 

 Introducing Application Service Roles 

 Assigning Multiple Roles 

 Selecting Application Service Roles 

Deploying Applications 

 Deploying Applications Using Group Policy 

 Deploying Applications Using System Center Tools 

Using Terminal Services 

 Understanding the Terminal Services Architecture 

 Planning a Terminal Services Deployment 

 Deploying Terminal Services 

 Selecting Server Hardware 

 Installing Terminal Services 

Using Virtualization 

 Understanding Virtualization Architectures 

 Introducing Hyper-V 

 Virtualizing Applications 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 

1 Installing the Terminal Services Role 

2 Configuring the Remote Desktop Connection Client  

3 Establishing a Terminal Services Connection 

4 Creating an RDP File 

5 Configuring RemoteApp Applications 

6 Creating RemoteApp RDP Files 

7 Launching RemoteApp RDP Files 
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5.3.5 Luku 5. Planning File and Print Services 

Viidennen luvun keskeiset asiat ovat resurssien jako, sekä tulostimien ja faxien 

konfigurointi. Resurssien jaossa tutustutaan jaettuihin kansioihin sekä jako- ja 

NTFS -käyttöoikeuksiin. Sen jälkeen esitellään hajautettu tiedostojärjestelmä 

(Distributed File System, DFS). Lopuksi asennetaan kirjoitin ja se julkaistaan 

aktiivihakemistossa. 

Esityskalvot 
 

Deploying File Servers 

 Designing a File-Sharing Strategy 

 Using the Distributed File System 

 Using File Server Resource Manager 

Deploying Print and Fax Servers 

 Understanding the Windows Print Architecture 

 Using the Print Services Role 

 Deploying a Fax Server 

Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Installing the File and Print Services Role 
2 Creating a Volume Using Share and Storage Manage-

ment  
3 Creating a Share Using Share and Storage Management 

4 Creating a DFS Namespace 
5 Adding a Folder to a Namespace 

6 Testing Namespace Access 
7 Adding a Namespace Server 

8 Installing a Printer 
9 Deploying Printers Using Active Directory 

5.3.6 Luku 6. Planning Storage Solutions 

Kuudennessa luvussa opiskellaan levyjärjestelmien perusteet, kiintolevytyypit, 

levyjen osiointi ja kehittyneet levyratkaisut, mm. RAID- ja SAN-levyjärjestelmät. 

Harjoituksissa luodaan ja hallitaan levyalueita (volume) ja rakennetaan raidoitettu 

(striped) levyasema. 

Esityskalvot 
 

Planning Server Storage 

 Estimating Storage Requirements 

 Selecting a Storage Technology 

 Planning for Storage Fault Tolerance 
Understanding Windows Disk Settings 

 Selecting a Partition Style 
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 Understanding Disk Types 

 Understanding Volume Types 

 Choosing a Volume Size 

 Understanding File Systems 
Working with Disks 

 Adding a New Disk 

 Converting a Basic Disk to a Dynamic Disk 

 Creating a Simple Volume 

 Creating a Striped, Spanned, Mirrored, or RAID-5 Volume 
Deploying a Storage Area Network 

 Understanding SAN Technologies 

 Using Windows Server 2008 with SANs 

 
Laboratorioharjoitukset  
 

Harjoitus Sisältö 
1 Creating a Simple Volume 
2 Extending a Volume Client  
3 Creating Additional Volumes 
4 Mounting a Volume 
5 Removing Volumes 
6 Creating a Spanned Volume 

 

5.3.7 Luku 7. Planning for High Availability 

Seitsemännessä luvussa keskitytään käytettävyyteen. Tarkastelu kohdistetaan 

kolmeen osa-alueeseen: tiedot, sovellukset ja palvelut. Tietojen varmistuksessa 

käytetään varjokopioita (shadow copies). Palvelimien käyttö varmistetaan 

kuorman tasauksella (Network Load Balancing, NLB) ja vikasietoisella 

ryvästyksellä (Failover Clustering). Lisäksi harjoituksissa asennetaan web-palvelin 

IIS (Internet Information Server). 

Esityskalvot 
 

Planning For Data Availability 

 Backing Up Data 

 Using Shadow Copies 

 Using Offline Files 

 Using Disk Redundancy 
Planning for Application Availability 

 Increasing Applications Availability 

 Planning for Applications Resilience 
Planning for Server Availability 

 Using Hardware Redundancy 

 Using Failover Clustering 

 Using Network Load Balancing 
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Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Creating a Volume 
2 Configuring Shadow Copies 
3 Deploying the Web Server (IIS) Role 
4 Installing Network Load Balancing 
5 Creating an NLB Cluster 
6 Adding an NLB Cluster 
7 Testing an NLB Cluster 
8 Removing an NLB Cluster 

 

5.3.8 Luku 8. Planning Server and Network Security 

Kahdeksannessa luvussa käsitellään verkon tietoturvaa. Keskeisinä aiheina ovat 

palomuurit ja Bitlocker-suojaus. Harjoituksissa tutustutaan jaettujen resurssien 

käyttöön ja suojaukseen.  

Esityskalvot 
 

Securing Servers 

 Physically Securing Servers 

 Building a Firewall 

 Using  BitLocker 

Securing Network Access 

 Understanding Authentication 

 Understanding Authorization 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Creating Users and User Groups 
2 Creating a Share 
3 Assigning Permissions 
4 Testing Share Access 

5.3.9 Luku 9. Secure Infrastructure Services 

Yhdeksännessä luvussa jatketaan tietoturvan käsittelyä. Teoriaosuudessa 

tutustutaan etäkäytön (Remote Access) tietoturvaan ja varmenteisiin 

(certificates). Harjoituksissa asennetaan Network Policy and Access 

Services -palvelu (NAP), rakennetaan VPN-yhteys koneiden välille ja rakennetaan 

varmennerakenne toimialueeseen. 
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Esityskalvot 
 

Securing Remote Access 

 Understanding Remote Access Connectivity 

 Installing Remote Access 
Using Certificates 

 Understanding Certificates 

 Planning a CA Deployment 

 Installing Certification Authorities 
Managing Certificate Templates 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Installing Network Policy and Access Services 
2 Configuring Routing and Remote Access Client  
3 Configuring a VPN Client 
4 Establishing a Connection 
5 Installing Active Directory Certificate Services 
6 Using the Certificates Snap-In 
7 Using Web-Based Enrollment 
8 Issuing a Certificate 
9 Retrieving a Certificate 

5.3.10 Luku 10. Manage Servers 

Kymmenennessä luvussa tutustutaan etähallintaan ja Microsoft Management 

Console -työkaluun, jonka avulla voidaan rakentaa hallintakonsoleita verkon, 

palveluiden ja laitteiden hallintaan. Seuraavaksi käydään läpi käyttöoikeuksien 

delegoinnin periaatteet. Lopuksi asennetaan palvelimien päivitykseen käytettävä 

WSUS-ohjelma ja käydään läpi ohjelman asetukset. Lisäksi harjoituksissa 

asennetaan web-palvelu IIS jäsenpalvelimeen. 

Esityskalvot 
 

Using Remote Administration 

 Using Server Manager 

 Installing Role Administration Tools 

 Using MMC Consoles 

 Using Remote Desktop 
Delegating Administration Tasks 

 Delegating File System Permissions 

 Assigning Group Managers 

 Delegating Active Directory Administrative Privileges 
Updating Servers 

 Understanding WSUS Architectures 

 Deploying WSUS 
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Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Creating an MMC Console 
2 Using Remote Desktop 
3 Installing the Web Server (IIS) Role 
4 Installing WSUS 

5 Configuring WSUS 
6 Using the WSUS Administrator Console 

5.3.11 Luku 11. Monitoring Servers 

Yhdennessätoista luvussa opetellaan palvelimen ylläpitoon liittyviä tehtäviä. 

Logien katsastamiseen käytettävä Event Viewer, suorituskyky-monitori 

(Performance Monitor) ja luotettavuusanalysaattori (Reliability Monitor) ovat 

oppijakson keskeisiä asioita. Myös normaalin suorituskyvyn dokumentointi 

(baseline), pullonkaulojen haku ja seuranta (auditointi) käydään läpi. 

Esityskalvot 
 

Using the Event Viewer Console 

 Introducing the Windows Server 2008 Event Viewer 

 Viewing Windows Logs 
Using the Reliability and Performance Console 

 Using Resource Overview 

 Using Performance Monitor 

 Using Reliability Monitor 

 Locating Bottlenecks 

 Using Auditing 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 

1 Using Event Viewer 
2 Using Performance Monitor 

3 Establishing a Baseline 
4 Viewing Data Collector Set Logs 

5 Using Reliability Monitor 

5.3.12 Luku 12. Backing Up 

Viimeisessä luvussa käydään läpi eri tapoja, joilla voidaan ottaa varmuuskopio 

palvelimesta. Tietojen varmistukseen käytetään Backup-ohjelmaa. Varmistus voi 

olla normaali (kaikki tiedostot valitusta kohteesta) tai valikoiva (inkrementaali tai 

differentiaali), jossa vain muuttuneet tiedot varmistetaan. Varmistus voidaan 

tehdä haluttuna ajankohtana tai ajastaa tietyn ohjelman mukaisesti. 
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Erikoistapauksia varmistuksesta ovat käyttöjärjestelmän ja aktiivihakemiston 

varmistukset. 

Esityskalvot 
 

Planning a Backup Strategy 

 Selecting Backup Hardware 

 Selecting Backup Software 
Using Windows Server Backup 

 Creating a Single Backup Job 

 Performing a Scheduled Backup 

 Configuring Incremental Backups 

 Performing a Restore 

 Restoring an Entire Server 

 Backing Up and Recovering Active Directory 

 
Laboratorioharjoitukset 
 

Harjoitus Sisältö 
1 Installing Windows Server Backup 
2 Creating a Backup Volume 
3 Performing a Single Backup 
4 Running an Incremental Backup 
5 Recovering Data 

 

5.4 Kurssin ajoitus 

Kurssin nimelliskesto on kahdeksan viikkoa ja 40 tuntia kontaktiopetusta, joka jakautuu 

luentoihin ja tietokoneharjoituksiin, laboraatioihin.  Työssä laadittiin kurssille 

tuntisuunnitelma. 

Viikko Ohjelma 
1 Luento 1, Harjoitus 1 
2 Luento 2, Harjoitus 2 
3 Luento 3, Luento 4, Harjoitus 3 
4 Luento 5, Harjoitus 4, Harjoitus 5 
5 Luento 6, Harjoitus 6 
6 Luento 7, Luento 8, Harjoitus 7, Harjoitus 8 
7 Luento 9, Luento 10, Harjoitus 9, Harjoitus 10 
8 Luento 11, Luento 12, Harjoitus 11, Harjoitus 12 

  

 

Toiminta lähiopetuksessa oli sellainen, että teoria ja luentokalvot esitettiin kunkin 

jakson alussa, minkä jälkeen opiskelijat tekivät harjoitukset omaan tahtiinsa. 

Harjoituksia voidaan tehdä etänä tunneloidun yhteyden kautta. Varsinkin palvelujen 
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asentamista sisältävät laboratorioharjoitukset vaativat aikaa, ja kesken jääneet 

tehtävät on mahdollista tehdä muuna ajankohtana, myös etänä. 

6 Kokemuksia kurssimateriaalista 

Kurssimateriaalia testattiin keväällä 2010 pidetyillä kursseilla. Toinen kurssi pidettiin 

nuorisoasteen päiväopetuksessa ja toinen avoimen ammattikorkeakoulun 

(aikuiskoulutus) iltaopetuksessa.  Käyttökokemukset voidaan jakaa kolmeen osa-

alueeseen, luentokalvot, harjoitukset ja harjoitusohjeet sekä virtuaalikoneympäristö. 

6.1 Luentokalvot 

Kurssikirja, kalvokopiot ja harjoitusohjeet sijoitettiin sähköisessä muodossa 

opintoportaaliin, josta ne olivat ladattavissa omalle koneelle. Kurssin esityskalvot 

seurasivat kurssikirjaa oivallisesti ja antoivat opiskelijoille hyvän yleiskuvan 

käsiteltävistä aiheista. 

Kalvot on rakennettu niin, että ne edellyttävät opettajan kommentointia eli toimivat 

taustamateriaalina. Niiden hyödyntäminen edellyttää läsnäoloa tunnilla. Kalvojen määrä 

ja sisällön laajuus noudattivat hyvin kurssille annettuja tavoitteita. Visuaalinen ilme on 

hyvä ja perustuu Metropolia:n viralliseen esityskäytäntöön. 

Luentokalvot antoivat periaatteessa tarvittavan teoriapohjan harjoitusten suorittamista 

varten. Vaikka opiskelijoille annettiin kalvokopiot sähköisessä muodossa, niiden 

sisältämä tieto ei yksin riittänyt keskeisten asioiden oppimiseen, vaan kurssikirjan 

käyttö osoittautui välttämättömäksi erityisesti harjoitustehtäviä suoritettaessa. 

Opiskelijoiden poissaolot osoittautuivat hieman ongelmallisiksi, koska kalvojen käyttö 

itseopiskelussa ei ole helppoa. 

6.2 Harjoitusohjeet 

Kurssiharjoitukset tukivat teoriaa. Niiden toteutus virtuaaliympäristössä on jouhea. 

Harjoitusohjeita oli helppo seurata ja ne etenivät loogisesti. Harjoitusten ja 

harjoitusympäristön laajuus ja monimutkaisuus muodostivat haasteen sekä opettajalle 

että opiskelijoille. Kurssin alussa jouduttiin käyttämään aikaa VMware-ympäristöön ja 

virtuaalikoneiden tutustumiseen. Usean virtuaalikoneen samanaikainen operointi ja 

toiminnan seuraaminen vaativat keskittymistä. Jokaisella opiskelijalla oli oma 
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virtuaaliympäristönsä, ja varsinkin aikuisopetuksessa erilaiset osaamisen lähtötasot 

osoittivat harjoitusten ohjaamisen tärkeyden.  

Opiskelijoiden poissaolot vaikuttivat selvästi oppimistuloksiin, koska harjoitukset on 

rakennettu niin, että ne etenevät loogisesti teorian mukaisesti ja perustuvat 

aikaisempien harjoitusten tuloksiin. Näin jo yhdenkin poissaolon vaikutus kertautui 

seuraavia harjoituksia tehtäessä. Koska harjoituksille oli varattu tietty määrä aikaa, ei 

tekemättä jääneitä harjoituksia ollut käytännössä mahdollista tehdä seuraavan 

harjoitustunnin aikana. Ne opiskelijat, jotka tekivät harjoituksia tunneloidun 

etäyhteyden kautta, pystyivät suorittamaan harjoitukset poissaoloista huolimatta. 

Muiden kohdalla tilanne oli ongelmallisempi. 

6.3 Virtuaalikoneympäristö 

Palvelinklusterin resurssit riittivät mainiosti harjoitusten suorittamiseen. 

Virtuaalikoneiden suuresta koosta huolimatta käynnistys ja operointi tapahtuivat 

ripeästi. Virtuaaliympäristössä oli helppo työskennellä, koska kesken jääneen 

harjoituksen pystyi tallentamaan.  

Jaettu verkko, jossa jokaisella opiskelijalla oli oma toimialueensa, aiheutti vikatilanteita, 

kun samaa toimialueen nimeä yritettiin käyttää useampaan kertaan. Ratkaisuna tähän 

olisi luoda jokaiselle opiskelijalle oma virtuaaliverkko, johon jäsenpalvelin liitetään. 

Tässä toteutuksessa ei kuitenkaan katsottu tarkoituksenmukaiseksi lähteä muuttamaan 

virtuaalikoneiden kokoonpanoa, koska se olisi vaatinut myös harjoitusohjeiden 

päivittämisen. 

Joissain kursseissa virtuaalikoneet on rakennettu harjoituskohtaisesti (esim. SharePoint 

2010), mutta tällä kurssilla ei katsottu järkeväksi lähteä tällaiseen ratkaisuun, koska 

virtuaalipalvelimille olisi tarvittu merkittävästi lisätilaa. 
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7 Yhteenveto 

Kokonaisen kurssin toteuttaminen vaatii paljon suunnittelutyötä. Monivaiheinen työ 

edellyttää myös organisointikykyä. Jälkeenpäin ajateltuna työn suunnitteluun olisi 

pitänyt käyttää enemmän aikaa ja tehdä yksi työvaihe huolella loppuun ennen uuden 

aloittamista. 

Työn tekemisen aloitin perehtymällä kurssikirjoihin. Kurssikirjoja oli kaksi. Toisessa 

kirjassa perehdyttiin syvällisemmin teoriaan ja toisessa laboratorioharjoituksiin. Laadin 

jokaisesta teoriakirjassa olevasta luvusta oman kalvosarjansa. Kalvosarja toimii kurssin 

teoriamateriaalina ja jokaisessa kalvosarjassa on tiivistettynä kirjojen luvuissa 

käsiteltävät asiat. 

Haastavin ja eniten aikaa vievä vaihe oli laboratorioharjoitusohjeiden testaus. 

Virtuaalikoneet olivat jo valmiiksi asennettuina ja se nopeutti testauksen aloittamista. 

Testaus tapahtui järjestelmällisesti oppikirjassa olevia tehtäviä läpikäyden. Koska 

laboratorion verkko ja virtuaalikoneet eroavat kirjassa käytetystä verkosta, jouduin 

harjoituksia läpikäydessä muokkaamaan niitä oppilaitoksen käytäntöön sopiviksi. Liitin 

harjoituksiin kuvia eri työvaiheista, koska ihmisen oppimiskyvyt ovat erilaisia. Jotkut 

oppivat muistamaan asiat helpommin kuvista kuin tekstistä. Näin varmistetaan, että 

kaikki hahmottavat mistä harjoituksissa on kyse. Toisaalta työvaiheita on 

monimutkaista selittää, joten kuvat selkeyttävät oppimismateriaalia. 

Tulevaisuudessa laboratorioharjoituksia on muokattava ainakin virtuaalikoneiden 

osalta. Jos laboratorion verkkoa muutetaan, niin esimerkiksi IP-osoitteissa voi tapahtua 

muutoksia. Oppilaiden palaute on myös tärkeää kurssin kehittämisen kannalta. 

Pyytäisin kirjallista palautetta opiskelijoilta kurssin jälkeen. Kirjallisen palautteen 

perusteella on helpompi kehittää kurssia oppilaan näkökulmasta katsoen. Näin 

kurssista tulisi enemmän oppilaita kiinnostava sekä heidän tarpeitaan vastaava kurssi. 

Olen tyytyväinen lopputulokseen, koska sain tehdyksi kurssin ja siihen kuuluvat 

oppimismateriaalit. Aluksi aikataulun pitkittyminen harmitti, mutta valmista työtä 

tutkiessani olen tyytyväinen, että joustin aikataulusta. Näin sain tehdyksi työni huolella 

loppuun ja kurssi on käyttökelpoinen. Opin työtä tehdessäni suunnitelmallisuuden 

tärkeyden. Ymmärrän myös paremmin opettajien tekemää työtä kurssien 

valmistelussa. Mielestäni työ on haastavaa, mutta samalla hyvin mielenkiintoista. 



31 

 

Lähteet 
 

[1] MCITP Self-Paced Training Kit (Exam 70-646): Windows Server 2008 

Administrator, ISBN 10: 0-7356-2510-7 

[2] http://www.microsoft.com/learning/en/us/exam.aspx?ID=70-646 (luettu 

10.6.2010) 

[3] Microsoft Official Academic Course Lab Manual Windows Server 2008 Administra-

tor ISBN 978-0-470-22510-3 

[4] Microsoft Official Academic Course Windows Server 2008 ISBN: 978-0-470-22511-

0 

[5] Windows Server 2008 R2 Tehokas hallinta, Jyrki Kivimäki ISBN: 978-952-565-578-

0 

[6]  http://fi.wikipedia.org/wiki/Windows_Server_2008 

[7]  http://www.microsoft.com/windowsserver2008/en/us/product-information.aspx 

[8] Virtuaaliympäristön suunnittelu, luominen ja testaus Microsoft Windows Server 

2008 Active Directoryn konfigurointi –kurssia varten. Tekijä Aleksi Renvall 

 

 

http://www.microsoft.com/learning/en/us/exam.aspx?ID=70-646
http://fi.wikipedia.org/wiki/Windows_Server_2008
http://www.microsoft.com/windowsserver2008/en/us/product-information.aspx


Liite 1 

  1(17) 

 

 

Liite 1. PowerPoint-esitys: Luku 1. Planning Server Deployments 
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Lesson 1
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13.4.2011 Kari Järvi 2

Skills Matrix

Technology Skill Objective Domain Objective #

Installing Microsoft 
Assessment and Planning 
Solution Accelerator

Plan server installations 
and upgrades

1.1

Understanding the 
Deployment Process

Plan for automated 
server deployment

1.2
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Selecting A Windows Server 2008 Edition

• Windows Web Server 2008

• Windows Server 2008 Standard

• Windows Server 2008 Enterprise

• Windows Server 2008 Datacenter

13.4.2011 Kari Järvi 3  

 

Assessing Windows Server 2008 Readiness

• Click Start, and then click All Programs > 
Microsoft Assessment and Planning Solution 
Accelerator > Microsoft Assessment and 
Planning Solution Accelerator. 

• In the actions pane, click Select a Database.

• Select one of the listed options, and click OK.

13.4.2011 Kari Järvi 4
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Assessing Windows Server 2008 Readiness

• In the details pane, click 
Identify Servers That Are 
Capable Of Running Windows 
Server 2008.

• Leave the Windows Server 2008 
Readiness Role and Migration 
checkbox selected, and click 
Next.

• Select one or more of the listed 
options, and click Next.

• On the Enter WMI Credentials 
page, click New Account.

 

 

13.4.2011 Kari Järvi 6

Assessing Windows Server 2008 Readiness

• Enter the credentials for a 
domain or local 
administrative account in 
the Domain Name, Account 
Name, Password, and 
Confirm Password text 
boxes. 

• Specify whether you want 
the wizard to use the 
credentials on all of the 
computers it finds or on a 
specific computer, and click 
Save.

 

 

Configuring a WDS Server

• Click Start, and then click Administrative Tools 
> Windows Deployment Services.

• In the scope (left) pane, expand the Servers 
node. 

• Right-click your server and, from the context 
menu, select Configure Server.

• Click Next to bypass the Welcome page.

13.4.2011 Kari Järvi 8  
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Configuring a WDS Server

• In the Path text box, key or browse to the folder 
where you want to locate the WDS image store.

• Click Next to continue.

• If the DHCP role is running on the same server 
as the Windows Deployment Services role, 
select the Do not listen on port 67 and 
Configure DHCP option 60 to „PXEClient‟ 
checkboxes, and then click Next.

13.4.2011 Kari Järvi 9  

 

Configuring a WDS Server

• Select one of the listed options. 

• Click Next to complete the configuration 
process.

• Select the Add images to the Windows 
Deployment Server now checkbox to launch the 
Add Image Wizard. 

• Click Finish to complete the Windows 
Deployment Services Configuration Wizard.

13.4.2011 Kari Järvi 10  
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Adding Image Files

• Click Start, and then click Administrative Tools 
> Windows Deployment Services.

• Expand the Server node and the node for your 
server. 

• Right-click the Boot Images folder and, from 
the context menu, select Add Boot Image.

13.4.2011 Kari Järvi 11  

 

Adding Image Files

• Key or browse to the location of the boot 
image you want to add to the store, and then 
click Next.

• Specify different Image Name and Image 
Description values for the image file you 
selected, if desired, and then click Next to 
continue.

• Click Next to continue.

13.4.2011 Kari Järvi 12  

 

Adding Image Files

• When the operation is complete, click Finish.

• Right-click the Install Images folder and, from 
the context menu, select Add Install Image.

• With the default Create a new image group 
option selected, supply a name for the group, 
if desired, and then click Next.

13.4.2011 Kari Järvi 13
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Adding Image Files

• Key or browse to the location of the install 
image you want to add to the store, and then 
click Next.

• Select the images you want to add to the 
store, and then click Next.

• Click Next to continue.

13.4.2011 Kari Järvi 14  

 

Adding Image Files

• When the operation is complete, click Finish.

• Close the Windows Deployment Services 
console.
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Configuring a Custom DHCP Option

• Click Start, and then click Administrative Tools 
> DHCP.

• In the scope pane, expand the node for your 
server.

• Right-click the IPv4 node and, from the 
context menu, select Set Predefined Options.

• Click Add.

13.4.2011 Kari Järvi 16  

 

Configuring a Custom DHCP Option

• In the Name text box, key PXEClient.

• From the Data Type drop-down list, select 
String.

• In the Code text box, key 060.

• Click OK.

• Click OK.

13.4.2011 Kari Järvi 17  

 

Configuring a Custom DHCP Option

• Click OK again to close the Predefined Options 
and Values dialog box.

• In the scope pane, right-click the Server 
Options node and, from the context menu, 
select Configure Options.

• In the Available Options list box, scroll down 
and select the 060 PXEClient option you just 
created.

13.4.2011 Kari Järvi 18  
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Configuring a Custom DHCP Option

• In the String Value text box, key the name or 
IP address of your WDS server, and then click 
OK.

• Close the DHCP Console.

13.4.2011 Kari Järvi 19  

 

Creating a Capture Boot Image

• Click Start, and then click Administrative Tools 
> Windows Deployment Services.

• Expand the Server node and the node for your 
server.

• Select the Boot Images folder.
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Creating a Capture Boot Image

• If you haven‟t done so already, add the 
Windows Server 2008 boot.wim image to the 
Boot Images store, using the procedure 
described earlier in this lesson.

• In the detail pane, right-click the boot image, 
and select Create Capture Boot Image from 
the context menu.
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Creating a Capture Boot Image

• On the Capture Image Metadata page, specify 
a name and description as well as a location 
and filename for the new image file.

• Click Next.

• Once the image has been created successfully, 
click Finish.
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Configuring WDS to Use an Answer File

• Copy your WDS client answer file to the 
\RemoteInstall\WDSClientUnattend folder on 
the WDS server.

• Click Start, and then click Administrative Tools 
> Windows Deployment Services.

13.4.2011 Kari Järvi 23
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Configuring WDS to Use an Answer File

• Expand the Servers 
node.

• Right-click the node 
for your server and, 
from the context 
menu, select 
Properties.

• Click the Client tab.

13.4.2011 Kari Järvi 24  

 

Configuring WDS to Use an Answer File

• Select the Enable 
unattended installation 
checkbox.

• Click the Browse button 
corresponding to the 
processor architecture of 
the client computer.

• Browse to your answer file, 
and then click Open.

• Click OK to close the 
server‟s Properties sheet.
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Configuring WDS to Use an Answer File

• Expand the node for your server and the Install 
Images node, and locate the image you want 
to associate with an answer file.

• Right-click the image file and, from the context 
menu, select Properties.

• Select the Allow image to install in unattended 
mode checkbox.
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Configuring WDS to Use an Answer File

• Click Select File.

• Key or browse to the answer file you want to 
use, and then click OK.

• Click OK to close the Image Properties sheet.
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Installing the Windows AIK

• Insert the Windows AIK disk you created into 
the computer‟s DVD drive.

• Click Windows AIK Setup.

• Click Next to bypass the Welcome to the 
Windows Automated Installation Kit Setup 
Wizard page.

• Select the I Agree option, and click Next.

13.4.2011 Kari Järvi 28  
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Installing the Windows AIK

• Click Next to accept 
the default settings.

• Click Next to begin 
the installation.

• Click Close.
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Creating an Answer File

• Insert your Windows Server 2008 installation 
DVD into the computer‟s drive.

• Open Windows Explorer, browse to the 
\Sources folder on the DVD, and copy the 
install.wim image file to a folder on the 
computer‟s local drive.

• Click Start, and then click All Programs > 
Microsoft Windows AIK > Windows System 
Image Manager.
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Creating an Answer File

• Click File > Select Windows Image.

• Browse to the folder on your local drive where 
you copied the install.wim image file, select the 
file, and click Open.

• Select the Windows Server 2008 edition you 
plan to install, and click OK.
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Creating an Answer File

• Click Yes to create a new catalog file.

• Click File > New Answer File.

• In the Windows Image pane, expand the 
Components folder, and browse to the 
component you want to add to the answer file.

• Right-click the component and, from the 
context menu, select one of the active 
configuration passes.
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Creating an Answer File

• In the Answer File pane, select the setting you 
added.

• In the Properties pane, select one of the listed 
settings, and key a value in the associated text 
box.

• Repeat the previous steps to add all of the 
settings you need to the answer file.
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Creating an Answer File

• Click Tools > Validate Answer File.

• Click File > Save Answer File As.

• Save the answer file to a local drive using the 
name Autounattend.xml.

• Copy the answer file to a floppy disk or flash 
drive.

• Close the Windows System Image Manager 
window.

13.4.2011 Kari Järvi 34  

 

Creating a Master Installation

• Insert your Windows Server 2008 installation 
DVD into the computer‟s drive.

• Insert the floppy disk or flash drive containing 
your answer file.

• Restart the computer by pressing 
CTRL+ALT+DEL.
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Creating a Master Installation

• When the installation is complete, check the 
system to make sure that all of the 
customizations you specified in the answer file 
have been completed.

• Open a Command Prompt window and, at the 
command prompt, key c:\windows\
system32\sysprep\sysprep. exe /oobe 
/generalize /shutdown, and press Enter.
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Deploying an Image File

• Turn on the new computer, and insert your 
Windows PE boot disk into the computer‟s 
drive.

• The computer boots to a Windows PE 
command prompt.

• Key diskpart at the command prompt, and 
press Enter.
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Deploying an Image File

• Enter each of the diskpart commands found on 
the next slide at the prompt, pressing Enter 
after each one.

• These commands create a new 40-GB partition 
on the computer‟s local disk, make the 
partition active, and format it.

13.4.2011 Kari Järvi 38  



Liite 1 

  16(17) 

 

 

 

Deploying an Image File

• Select Disk 0

• Clean

• Create Partition Primary Size=40000

• Select Partition 0

• Active

• Format

• Exit
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Deploying an Image File

• Map a drive to the share you created on your 
technician computer by typing the following 
command and pressing Enter:
net use z: \\computer_name\images

• Copy the image file you created earlier to the 
computer‟s local drive by typing the following 
command and pressing Enter: 
copy z:\winstall.wim c:
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Deploying an Image File

• Use the ImageX.exe program to apply the 
image to the computer by typing the following 
command and pressing Enter:
d:\imagex.exe /apply c:\winstall.wim 1 c:

• Shut down your new computer.

13.4.2011 Kari Järvi 41
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Liite 2. Tietokoneharjoitus: Luku 3. Deploying Active Directory 
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     Exercise Information 

Before starting record your IP addresses and computer names here. The 

names are as follows:  

LuokkaDCxx and LuokkaSRVxx (where Luokka=your class ID and 

xx=student/group number).  

The group number and IP addresses are provided to students by the in-
structor.  Fill the values in empty boxes below. 

 

LuokkaDCxx = LuokkaDC       10.95.250.HHH = 

 10.95.25. 

LuokkaSRVxx = LuokkaSRV  10.95.250.HHH+1 = 

 10.95.25. 

 

     Exercise 1: Connect to virtual machine LuokkaDCxx 

 Open Remote Desktop Connection 1.

 Start a session to 10.95.250.HHH 2.

 

       

 Log in as Administrator (password: Passw0rd!) 3.
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     Exercise 2: Check LuokkaaDCxx settings and Computer 

name 

 Check the IP address: 10.95.250.HHH/23 (mask 255.255.254.0). 1.

Change if necessary! 

 Set the DNS address to: 127.0.0.1 (localhost) 2.

 Check computer name (LuokkaDCxx). Change if necessary! 3.

     Exercise 3: Install AD and DNS Roles on LuokkaDCxx 

 Start Server Manager, expand Roles, start AD installation wizard 1.

 

 Accept welcome message by clicking Next. 2.

         

 Accept Compatibilty message by clicking Next. 3.
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 Type Domain name Contosoxx, where xx=student/group number. 4.
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 Set Forest functional level to Windows Server 2003 or 2008. 5.

         

 Select DNS role. 6.
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 Accept DNS diagnostics message. 7.

 

          

 Accept default names and locations.  8.
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 Give Restore Mode password: Passw0rd! 9.
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Review the installation summary and click Next. 10.

 

 

Wait until AD DS is installed.  11.
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Accept the installation by clicking Finish. 12.

 

              

Restart your virtual computer. 13.
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Exercise 4: Domain Controller DNS Configuration 
 

 Start a Remote Desktop session to LuokkaDCxx 1.

 

           

 Log in as Contosoxx\Administrator (password: Passw0rd!) 2.

  

 Set the LuokkaDCxx DNS address to: 10.95.250.HHH (its own IP ad-3.

dress) 

 Start DNS console 4.

 Add member server LuokkaSRVxx host (A) record to Contosoxx For-5.
ward Lookup Zone.  
 

Note! The names and addresses in the figure below are not correct! 
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 Create an IPV4 Reverse Lookup Zone (Primary, ADI) 10.95.250 6.

 Add Domain Controller (LuokkaDCxx) and member server (Luok-7.
kaSRVxx) Pointer (PTR) records to 250.95.10.in-addr.arpa Zone.  

Note! The names and addresses in the figure below are not correct! 

 

 

 Add IP forwarders: 8.
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      Exercise 5: Joining member server LuokkaSRVxx to        

Domain 

In this exercise, you will join member server LuokkaSRVxx to  

Contosoxx.com domain. 

 Open Remote Desktop Connection 1.

 Start a Remote Desktop session to 10.95.250.HHH+1 (Luok-2.

kaSRVxx, member server) 

 

            

 Log on to LuokkaSRVxx as local Administrator (password: 3.
Passw0rd!) 

 Open Network Connections 4.

 Check the IP address: 10.95.250.HHH+1/23 (mask 255.255.254.0) 5.

and change if necessary! 

 Set the DNS address to: 10.95.250.HHH (LuokkaDCxx) 6.

 Check computer name (LuokkaSRVxx). Change if necessary! 7.

 Join to Contosoxx.com domain: 8.

  Open System Properties and select Change. 9.
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 Type domain name Contosoxx, where xx=student/group number. 10.

Click OK. 
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Give domain administrator’s credentials: Administrator, password 11.

Passw0rd! 

 

Accept diagnostics message by clicking OK. 12.

 

Reboot member server LuokkaSRVxx. 13.
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    EXERCISE 6: INSTALL SERVER FEATURES ON LUOKKASRVXX 

BY USING SERVER MANAGER. 

 

1. Open Server Manager. Disable IE ESC for Administrators.  
 

 

2. In the Server Summary section under Security Information, click 

Configure IE ESC. The Internet Explorer Enhanced Security Configu-
ration dialog box appears. 

3. Under Administrators, select the Off option, and click OK.  

4. Add the following features to LuokkaSRVxx by using the Add Features 
Wizard:  

 Group Policy Management  

 Remote Server Administration Tools: Active Directory Domain 

Services Tools 

5. In the tree pane, select the Features node, and click Add Features. 
The Add Features Wizard appears, displaying the Select Features 

page. 

6. Select the Group Policy Management checkbox.  

7. Expand Remote Server Administration Tools and Role Administration 

Tools. Then, select the Active Directory Domain Services Tools 

checkbox, and click Next. The Confirm Installation Selections 
page appears.  
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8. Click Install. The wizard installs the features you selected. 

9. On the Installation Results page, click Close.  

5. Restart and log on to LuokkaSRVxx with the user name, Con-
tosoxx\Administrator, and the password, Passw0rd! 

6. Restart the computer when the wizard prompts you to do so. 

7. When the computer restarts, log on as Contosoxx\Administrator and 

the password, Passw0rd!. The Server Manager console opens, and 
the Resume Configuration Wizard appears.  

    On the Installation Results page, click Close.  


